Using Kinco HMIs
with

MAC motor® & ServoStep® & SMC66..85

After installing the HMIware software and the correct USB-driver, you are ready for

creating and downloading projects to your Kinco HMI panels.
In this short Quick Start Manual the following points are covered:

1. Creating a new project
1 One HMI and One ServoStep® or MAC motor®
1 One HMI and Multiple ServoStep®s or MAC motor®s
®  Multiple HMIs and Multiple ServoStep®s or MAC motor®s

2. Designing HMI screens — Register Types

1 Mix of 16 bit and 32 bit (MAC 50..141 + SMC75/1t Gen. MIS23x)

1 Only 32 bit (MAC 400..3000 + SMC66/MIS17x/MIS23x(2" Gen) + SMC85/MIS34x..)

3. Placing different Controls on the Screens
B Text
1 Number Inputs
1 Number Display
1 Function Keys

4. Save the Project and Download it to the HMI
B Save the Project
1 Compile the Project
1 Simulation and Download to the HMI

1. Creating a new project

File — New:

Project Name |—|—ESt |

Project Path ChPragram Files xBE\KInco\inco Hidlware w2 fprojecthTest  »» |

Dk Cancel

Choose a Project Name and click <OK>.
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Now drag the relevant HMI unit onto the grey canvass grid:

f,l' CAProjects\ElectricCylinder\MacTalk_201"\MacTalk_2017.wpj - [MacTalk_2017 *]

i1 File(F) Edit(E) View(V) Screen(P)

N[ o )
REEIa ISR BENS

e}

Draw(D) Components(I) Tools(T) Op

M'—.@')B Iz
B Yk @ EEE |

Graph element window b

Connector

B B @R

MT4424T MT4414TE... MT4414T(S)

4 A2 [4

MT4404TF  MT4404T MTA403TE

Next drag the PLC type “MAC

Motor” to the grid:

Graph element window b

Connector
HMI
PLC
o~
Lust LustBus  MAC Motor
Ethern...

Drag the Connector type “Serial Port” to the grid and connect the ends to the HMI ComO
port respectively to the MAC Motor (covers MAC motor®, Serngtep® and SMC66..85):

Graph element window kS

Connector |
o7 _}
Ether... CAN

Now make sure that the Serial

Graph element window x

Port connector is connected in BOTH ends:

Connector
o7 __)
Ether... CAN

"HRA -

Tip: if you move HMI up-and-down and PLC up-and-down, then the connector MUST
follow (as shown) otherwise it is not connected in both ends.
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1 pcs HMI + 1 pcs ServoStep®/ MAC motor®

HrAlID

PLCO:255,

COMT
HTOMD

Multiple HMIs and Multiple ServoStep®s or MAC motor®s
. PLCO:26RE,
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Now setup the parameters

After creating the project — first check that the PLC = “MAC Motor” in Kinco software and
the MAC motor or ServoStep motor have the same addresses. See below how to setup

address in JVL's MacTalk software.
MAC motor = “PLC” must have an Address No. in the range 1...254 (i.e. NOT 0 = zero).

N PLC Attribute

PLC |

Station Mo. ﬂ

rNetwork Ports

In MacTalk® (1) key in the address on the Main tab, (2) press Enter and (3) click “Save in

motor”:

i “MacTalk - Noname

Files View Offline ePLC Setup Updates Help

& .8/ &\ B & & &

Open Save Save in motor [Reset position  Clear errors ~ Reset motor Fiter setup STOP
= Serial port ~—/ @ Comport: 1 : | Baud: 19.200 : | Motor Address
Tests | Scope

Change actual mode %/ Error handling

@ Passive @Change actual mode Max. follow errors 0 C
Velocity B )
Position Position/Rot. Table -Min 0 C
Gear Position/Rot. Table -Max 0 C
Gear(Follow)
Analogue velocity Error deceleration 0 R

Analogue Velocity(with deadband)

Analogue velocity/gear %/ Inputs/Outputs
Velocity/analogue torque Output 1 (O1) User controlled
Analogue torque (direct) Output 2 (02) User controlled
2”?"}9”8 gear Invert In position output (O1)
o o Invert Error output (02)
Analogue bi-position )
1/0 Type Serial Data =

Analogue to position

Positive edge position capture

Profile data

Max Velocity 100 - RPM Negative edge position capture
) = Disable brake

g ada 87 3 s Analogue input offset (Mode) 0.00 v
S-Curve Off - Analogue input offset 1 0.00 v
Torque e E Analogue input offset 2 0.00 Vv
Load L z Unts %/ Undervoltage handing

Invert motor direction Undervoltage -> Set error bit

Undervoltage -> Stop controlled and go to passive
Undervoltage -> Set velocity to 0
d = New

Communication
Motor address Current
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Next set the “Serial Port 0 Setting” Type to either RS232 or RS485-2.

For ServoStep® and SMC66..85 you have to always select only RS485-2.

Using the WI0060 cable provided by JVL (HMI RS485 Cable 5m, MAC-R4 +MIS +SMC)
you have to select RS485-2.

- HiAID -

CORE .

oMo ]
| HMI Attribute
HMI System Information Text I Security Levels Setting
HMI |  TaskBar |  HMiLicenseSeting |
Histarical Events Storage | Print Setting COMD Setting | Co
Type RS4852 . PLC Communication Time Qut
Baud Rate 19200 © Protocol Time Out 1(ms)
Data Bit 8 - Protocol Time Out 2{ms)
Parity Check none . Max interval of word block pac
] Max interval of bit block pack
Stop Bit 1 ©
Max word block package size
[T Broadeast 65535
May hit hlnrk narkana cize

Keep values for ‘Baud Rate’ (19200), ‘Data Bit’ (8), ‘Parity’ (none) and ‘Stop Bit’ (1), and
leave all other values un-changed unless you have a specific reason to change them.

On next page you can see how to design HMI screens...
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2. Designing HMI screens — Register Types

Before placing control elements on the screen which refer to Registers in the motor, you
need to be aware that you must choose Addr. Type as either W_Reg or DW_Reg.

MAC 50..141 (154+2" Gen.) + MIS 23x (15t Gen)/SMC75: mix of 16 bit and 32 bit registers.
MAC400..3000, MIS17x..23x..34x..43x /| SMC66/85: always ONLY 32 bit registers.

If it's a 16 bit motor register use W_Reg. (MAC 50..141 + MIS 23x + SMC75).
If it's a 32 bit motor register use DW_Reg. (MAC400+, MIS34x and SMC66/85).

Example of 32 bit Number display (Actual
Position):

Example of 16 bit Number input in

Number Display Corponent Attribute
Graphics ] Control Setting ] Dizplay Setting ] Basic Attributes l MurnendD ata ] Font ] Graphics ] Dizplay Setting
Bazic Atibutes ] umeric Data | Fant | Keyboard Setting |
PFricrity
Priciity
Iv Read Address Same Asfiiite Address
Read &Address Wwiite Addiess
Fead Address ‘write Address
PLC PLC
4 HMI HiI 1] - Hidl
Wil EEEET] B o - | Hm o Me. Mo
) ) Poart COMO Part COmMD
Fart COomMO Fart ComMo h
Change 5 angeN -
StatiognNum 2 Cl
add Type  w_Feg - Addi Type Addr. Type  D'w_Reg - Addr. Type
Address 5 [ Suster Register Addiess r Address 10 M S (g el 2
Code Wwhard Code Wwhard
Code . word Code whord BIM <
Type BN Length Type Length ;we S D"egr;g;g Type Lewein
Formal{RangelDDOD (0-3339) Format{Fange): DDDD (0-9939) ormat{Range]! (0-9333)
~ I r r
B Uss ip fidmmesis r [ Use the index register r
Description NID Description NDO
Cancel (] 8 | Cancel

3. Placing different Controls on the Screens
Text
Using the Text tool (“A”) key in the desired text:

n{0) Window(W) He

1o oalmo-1

s ol -

Choosinc.; “Graphics Mode” and “Vector Font” you can specify the Font, color and size etc:

Text | Display Setiing |

Content

Text

Eont Font style: Size

[Regular 7

m|>

Ol v v e he
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Number Input
Now place a Number Input on the screen — in this example the Set Position:

TSRS T Number Input Component Attribute

Connector
HMI : Basic Affributes |Numeric Datal Font | Keyboard Setting | Graphics | (
PLC |
FAY BN N LTS e I?LI_I.EIF:.EHS [ A LW S ) Prlorlty rﬂl:llnTal -
P
| |7 Read Address Same As Write Address
E k | . 2 | ~Read Address ~Write Address—
Recipe Data  Event Indirect | pLC
Display Window HMI HMio - No 0 @ HMI HMID
' 5 ' Port CoMD Port COM
i | |
) » r Change Station . - Change Static
Number Text Display Number . MNum o
Display Input
R = | Addr. Type DW_Reg < Addr. Type l
g &
Text Input  Oscillogra... Video Address ~ System Register Address 0
Code Word Code )
BIN = 2 = BIN
."\: g [ ] I T il
{71 W M ype Length ype

And it can look like this:
Graph element window

Connector
HMI
PLC
PLC Parts
\ MNumber Input Component Attribute
E f' j 2| E
. L Basic Aftributes | Mumeric Data  Font | Keyboard Setting | Graphics | Control Settin
Recipe Data Event Indirect
Display Window
—Font Type
- |
[@ iﬂ__ [—13':5 (8 Vector Font (" Dot Matrix Font
Number Text Display Number
Display Input — Font Attribute
)
[__"‘:{? _4_‘ &) Font Microsoft Sans Serif -
Text Input  Oscillogra... Video Size: 24 . Algnment Right .
[ : 7 =
Y om m

B asic Attibute Mumernic Data ]Trigger .&ddress] Font ] Graphics] F'u:usitiu:un]

[ata Type %
Digitz Above Decimal-Paoint 11 -

Digitz Below D ecimal-Paoint 1] -

Min. Walue -2147483647 M am WYalue 2147483647

[ Project Data Conversion

Fro.Min Value Pro.Mas Value
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Next place a Number Display on the screen — in this example the Actual Position:
Actual Position .

e,

Data Display Component Attribute k

B azic Attribute l M umeric Data] Fori ]

Pricrity

Input Address Output Address

HHMI HMin - PLC HMI PLC
Addi.Type [ B = Addn. 10 Addr. Type Addr.
Code Type BIMN = Fomat:DDDD Code Type

Wordo, 2 - [ wordNo. I~

Basic Attribute  Numeric: D ata l Fort |

Data Type zighed int

Digits Above DecimakPoirt 1 - %
Digits Below Decimal-Point ] -

Min. W alue 2147483647 Max, Walue 2147483647

Finally place a Function Key on the screen — in this example a STOP key used for
stopping a running motor (by Ioadlng the VeIOC|ty reglster (# 5) with 0):

Multi-State Setting Component Attribute

B asic Attibute lMuIti-State Setting] Tag ] Graphics] F'u:usitiu:un]

Pricrity

Input Address Output Address

Hedl PLC Hedl HMID = PLC 1] -
Addr. Type Addr. Addr. Type 5

Code Type Code Type BIM + pefmat:DDDD
wardMa. ~ WardNa, 1 - [
Description STOP - zet-zoll to zero, i.e. brake the gadtor to 0 velocity

Basic Attibute  Multi-State Setting l Tag ' raphics] F'u:usitiu:un]

Settinghd ode (RN

Set Y alue 1]
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Basic Attibute | Muli-State Setiing  Tag lGlaphics] F'Dsition]

[+ UseTag Language Danish - I~
Taq List Text Library

State Mo. | Conbent | Aligh | Fort Size | Font Colar |
1] STOP Center 16

1 Left 16 ]

B azic Attribute] Mulb-State Setting] Tag Graphics l PDSitiDn]

MNUR_CLOSEDD . wg =

-

Import Graphics

Graphics State 1] -

MAC motor® + HMI-420T

Sieti FljSif iﬁ|1

FEREBREERE

fictual Position

R A Rl o
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Register Types in the HMI vs in the motor controllers can be seen below.

Whenever it is necessary you can limit the register values to either the full range shown
below (taken from the MAC motor manual) or to lower values thus preventing the operator

to key i

n

values that leads to mecha

nical failure.

= ERARE - o BEOERE - Dae - Lus - D

Basic Atribute Mumeric Date | Trigger Address| Font | Graphics | Fosition|
pEEE unsigned it g Basic Attribute Hameric Dats |Trigger Address|Font | Graphics | Position )
Digits Above Decimal-Paint 5 - 4
oaTee | EECEEENT]
Digits Below Dgcimal-Point 0 <
Digits Above Degcimal-Point 5 -
D J Max Value 65535 Digs Below Delcimal-Point 0 -
I™ Project Data Conversion o 22767 Max Value 32767
.~ Fro 3 PEANY Data Input Component Attribute
ProMin Val Basic Attribute Hameric Dats |Trigzer Address |Font | Graphics|Pesition|
Data Type signed int -
Digits Above Oecimal-Point n <
Digits Below Dcimal-Point 0 -
Min. Value -2147483647 Max. Value 2147483647
Integert | 6 bit signed. | = -
2 roject Data Conversion Data Display Component Attribute
Range: -32767 ... +327,
Pro.Min Value Pro.Max Valug Basic Attribute Fumeric Data IFom |
Longlmts32 bit signed. DataType | [EENEERROONE -]
H Range: -2.147E9 ... +2.147E9 Digits Above Dpcimal-Foirt 1 -
~Digitz Below Dgcimal-Poirt 6 ~
Fixed4: +6-bit-sigred-fixed point. cores -
Min. Value 79397 Max. Value 79987
Range: -7.999756 ... +7.999756
Unit' | , 4096 [ Project Data Conversion
Pro.Min Value Pro.Max Value
Eixed8: 16 bit signed fixed point. [y eI SIS r " X
Basic Mtribute Mumeric Date |Font |
baa T | (TN
Digits Above Pecimal-Point 3 -
i
E= [~~-Qigts Below ecmal-Part 3 -
o Min. Value 127396 Max. Value 127936
#
= ™ Project Data Conversion
Pro.Min Value Pro.Max Value
i e _ ;
o = [154 o [
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4. Save the Project and Download it to the HMI

In the File menu choose Save All.
Then in the Tools menu you need to Compile the project (Ctrl + F7) — check if there are no

errors:

Function Parts

Message win

findowFramed
findowFrame
findomFrame2
findomFramed
WwindowFramed
wfard Library
Graphicz Library
tacrocode...
Connecting...

Compilation Donel Evror Ol

=

o

Ready

If you wish you can choose the Offline Simulation (F5 in the Tools menu), then click

“Simulate”:

Graph element window =

Connector

HMI

PLC
e

w L B

Recipe Data Event Indirect
Display ‘Window
@ e
Number Text Display Number
Display Input

5 @ &

Text Input  Oscillogra Video

G m  m

Note Book  Multiple Bit State
State Ne.. Neon Lamp

— p— = —
_y | === X =
Trigger Grid Historical
Touch Data Di...

-
(4 =
Operation  Historical Camera

Log Event D...

;EQ KHSimulator

~ HMI Simulatic

HMI Station

Hhl Information

HiID

| Simulate

on Serial Por

(COMDy  COM1

HMI Port PC Port

Hbl Port PC Part HI Part PCFort
(COM1y  COM1 - (CONMZ) COm1

r~ Show Informatio

Simulation Type

File Path( pkg)

Communication Type

Offline Simulation

chprogram files (BE)\kincoinco hmiware v2 4projectisst
\estpkg

NULL

IP: |NULL

PORT: ‘NULL

COM |NULL

BPS ‘NULL

® ®
FWR  CPU

MAC motor® + HMI-4A20T

Set Position

Actual Position

0

COoM
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Test values can be keyed in using the mouse. Click the desired value and a keypad similar
to the real pop-up keypad in the HMI will appear and you can now use the mouse to click
the number buttons and finally clicking ENT (Enter):

motor® + HMI-420T

Set Position

10000

Actual Position

4

Finally you just need to Download the project to the HMI from the Tools menu (Ctrl + D),
then click the Download button and watch the HMI screen.

Graph element window ®
B == KHDownload
Connector
HMl W Select HwE: - Select Sectionn———————————
PLC HMI Station HMI Information Datafile
PLC Parts O Recipe file
~ [ LoGO file
ﬁ:j ‘I__J | =) O clear recipe
y. 3 ! - |
. . Clear hist t cliat
Recipe Data Event Indirect [ Clear histary event deta
Display Window D Clear history record data
s . Clear data report
@ e = O p
Number Text Display MNumber i Download File Path: chprogram files (xBE)ikincoikinco hriware v2.4\projectitest [ Clear ERWY data
Display Input EEERE [ Clear FRW data
)
5 = & [ Download to USET
Text Input  Oscillogra... Video [ Download to USEE
R ] [ Download to 5D
f ’ ﬁ;iw ﬂi:d!s Communication Type:
Note Book  Multiple  Bit State i O Timeou: 5000
State Ne.. MNeon Lamp i : |NULL PORT  [MULL
= (1 second =1000 Ms)
— — Bl =
Lo ' o =
: = b Download
Trigger Grid Historical COM: |NULL EIPE
Touch Data Di... Ewit

BB

Congratulations - you have now finished your first project !
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